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はじめに

本書は表示器（GP3000 シリーズ）と接続機器（対象 PLC）を接続する方法について説明します。

本書では接続方法を以下の順に説明します。

1 システム構成

接続できる接続機器の種類、通信方式につ

いて示します。

「1 システム構成」（3 ページ）

2 接続機器の選択

接続する接続機器の種類 (シリーズ )と接

続方法を選択します。

「2 接続機器の選択」（5 ページ）

3 通信設定例

表示器と接続機器間で通信するための設

定例を示します。

「3 通信設定例」（6 ページ）

4 設定項目

表示器側の通信設定項目を説明します。

表示器の通信設定はGP-Pro EX、またはオ

フラインモードで設定します。

「4 設定項目」（13 ページ）

5 結線図

表示器と接続機器を接続するケーブルや

アダプタについて示します。

「5 結線図」（18 ページ）

運転
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1 システム構成

表示器と Siemens 製接続機器を接続する場合のシステム構成を示します。

■ 接続構成

• 1:1 接続

シリーズ CPU モジュール 接続ポート 通信方式 設定例 結線図

SIMATIC
S7-200 シリーズ

CPU214
CPU215
CPU216
CPU221
CPU222
CPU224
CPU226

CPU ユニット上の
ポート 0/1

RS422/485
（2 線式）

設定例 1 
（6 ページ）

結線図 1 
（18 ページ）

SIMATIC
S7-300 シリーズ

CPU312IFM
CPU313
CPU314
CPU314IFM
CPU315
CPU315-2 DP
CPU316
CPU316-2 DP
CPU318-2

CPU ユニット上の
MPI ポート

RS422/485
（2 線式）

設定例 2 
（9 ページ）

結線図 1 
（18 ページ）

※ 1

結線図 2 
（24 ページ）

※ 1 この結線図は以下に示す MPI と PROFIBUS が同じポートの機種専用です。

SIMATIC
S7-400 シリーズ

CPU412-1
CPU412-2 DP
CPU413-1
CPU413-2 DP
CPU414-1
CPU414-2 DP
CPU414-3 DP
CPU416-1
CPU416-2 DP
CPU416-3 DP
CPU417-4

CPU ユニット上の
MPI ポート

RS422/485
（2 線式）

設定例 2 
（9 ページ）

結線図 1 
（18 ページ）

※ 1

結線図 2 
（24 ページ）

S7-300 シリーズ 318-2(6ES7 318 2AJ00)

S7-400 シリーズ

412-1 (6ES7 412 1XF03)、412-2DP (6ES7 412 2XG00)、
414-2DP (6ES7 414 2XG03)、414-3DP (6ES7 414-3XJ00)、
416-2DP (6ES7 416 2XK02)、416-3DP (6ES7 416-3XL00)、
417-4 (6ES7 417-4XL00)
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• 1:n 接続

• n:1 接続

• n:m 接続

• SIMATIC S7 MPI 直結ドライバのバージョンが V1.00.04 以上の場合、1 つの接続構成に

S7-300/400 シリーズと S7-200 シリーズを混在させることができます。

V1.00.03 以下の場合、混在させることはできません。

• S7-200/300/400 シリーズのみ n:1 接続をサポートしています。

• 接続機器１台に接続できる表示器の最大台数は接続機器の種類によって異なります。各

接続機器のマニュアルで確認してください。

• S7-200/300/400 シリーズのみ n:m 接続をサポートしています。

• n:m 接続の場合、表示器と接続機器の台数は以下の条件を満たす範囲となります。

•表示器１台に接続できる接続機器は最大 16 台です。

•接続機器１台に接続できる表示器の最大台数は接続機器の種類によって異なります。

各接続機器のマニュアルで確認してください。

16

n

n m
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2 接続機器の選択

表示器と接続する接続機器を選択します。

設定項目 設定内容

メーカー 接続する接続機器のメーカーを選択します。「Siemens AG」を選択します。

シリーズ

接続する接続機器の機種（シリーズ）と接続方法を選択します。「SIMATIC S7 
MPI 直結」を選択します。
「SIMATIC S7 MPI 直結」で接続できる接続機器はシステム構成で確認してくださ
い。

「1 システム構成」（3 ページ）

システムエリアを使用
する

表示器のシステムデータエリアと接続機器のデバイス（メモリ）を同期させる場
合にチェックします。同期させた場合、接続機器のラダープログラムで表示器の
表示を切り替えたりウィンドウを表示させることができます。

参照：GP-Pro EX リファレンスマニュアル「付録 1.4 LS エリア（ダイレクトア

クセス方式専用）」

この設定は GP-Pro EX、または表示器のオフラインモードでも設定できます。

参照：GP-Pro EX リファレンスマニュアル「6.13.6［システム設定ウィンドウ］

の設定ガイド■ [ 本体設定 ] の設定ガイド◆システムエリア設定」

参照：GP3000 シリーズユーザーズマニュアル「4.3.6 システムエリア設定」

ポート

接続機器と接続する表示器のポートを選択します。

• S7-300/400 シリーズと接続する場合は COM2 を選択してください。
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3 通信設定例

（株）デジタルが推奨する表示器と接続機器の通信設定例を示します。

3.1 設定例 1

■ GP-Pro EX の設定

◆通信設定

設定画面を表示するには、ワークスペースの [ システム設定ウィンドウ ] から [ 接続機器設定 ] を選択

します。
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◆機器設定

設定画面を表示するには、[ 接続機器設定 ] の [ 機器別設定 ] から設定したい接続機器の ([ 設定 ])

をクリックします。

[ 接続可能台数 ] が複数の場合は [ 接続機器設定 ] の [ 機器別設定 ] から をクリックすることで、

設定できる接続機器を増やすことができます。

■ 接続機器の設定

S7-200 シリーズの通信設定は、ラダーソフト「STEP 7 Micro/WIN 32」にて行います。

(1) メニューリストの [Communication] をクリックします。接続機器（PORT0）－ラダーケーブル

（PC/PPI Cable）－パソコンの接続を確認し、[Double-Click to Refresh] をダブルクリックします。

(2) [Search for Addresses] ダイアログボックスが表示され、接続機器を自動的にスキャンします。接続

を確認するとダイアログボックスが閉じます。

(3) メニューバーの [PLC] → [Type] を選択します。

(4) [PLC Type] ダイアログボックスが表示されます。接続されている接続機器のタイプに合わせて選

択し［OK］ をクリックします。

(5) メニューリストの［System Block］をクリックし、実際に表示器と接続するポート（Port0/Port1）

に合わせて、下記のように設定してください。

(6) 設定が終了したら [OK] をクリックしダイアログボックスを閉じます。

(7) コマンドメニューの [Down load] ボタンをクリックします。

(8) [Download] ダイアログボックスが表示されます。[Program Block]、[Data Block]、[System Block] の

すべてにチェックを入れ、[OK] をクリックします。

項目 設定内容

PLC Address 2

Highest Address 31

Baud Rate 19.2k

Retry Count 2

Gap Update Factor 10
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◆制限事項

■ドライバのバージョン V1.00.03 以下の制限事項

• S7-300/400 シリーズの TimeMaster 機能をサポートしていませんので、TimeMaster 機能を使用した

時刻合わせはできません。使用した場合、表示器の通信が数秒間途切れたり、通信エラーが表示

される場合があります。TimeMaster 機能を使用しないでください。

• 1 つの接続構成に S7-300/400 シリーズと S7-200 シリーズを混在させることはできません。

■ドライバのバージョン V1.00.04 以上の制限事項

• 通信速度は、最大 187500bps です。

V1.00.03 以下で作成したプロジェクトで通信速度が 500kbps 以上に設定されていた場合、表示器

本体でエラー表示されます。

• 1 台の表示器で複数のドライバを使用する場合、Rockwell Automation, Inc の DH-485 ドライバと同

時に使用することはできません。

また、COM1 と COM2 の両方で SIMATIC S7 MPI 直結ドライバを使用することはできません。
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3.2 設定例 2

■ GP-Pro EX の設定

◆通信設定

設定画面を表示するには、ワークスペースの [ システム設定ウィンドウ ] から [ 接続機器設定 ] を選択

します。

◆機器設定

設定画面を表示するには、[ 接続機器設定 ] の [ 機器別設定 ] から設定したい接続機器の ([ 設定 ])

をクリックします。

[ 接続可能台数 ] が複数の場合は [ 接続機器設定 ] の [ 機器別設定 ] から をクリックすることで、

設定できる接続機器を増やすことができます。
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■ 接続機器の設定

S7-300/400 シリーズの通信設定は、ラダーソフト「SIMATIC Manager」にて行います。

下記手順に従って、以下のように設定します。

(1) [ 新規作成 ] のアイコンをクリックします。

(2) 任意の名前をつけ [OK] をクリックします。

(3) メニューバーより [Insert] → [Station] → [1 SIMATIC 400 Station] を選択します。

(4) プロジェクト内に「SIMATIC 400(1)」が作成されます。CPU 内の [Hardware] をダブルクリックし

ます。

(5)「HW Config」画面が表示されます。左のツリーより [SIMATIC 400] → [RACK ‐ 400] を開き、使

用している型番のベースユニットを選択し、右上のウインドウにドラッグ＆ドロップします。

(6) 設定したラックの中に、使用する電源ユニットをドラッグ＆ドロップします。

(7) 同様に、使用する CPU ユニットをドラッグ＆ドロップします。

(8) 設定した CPU ユニット「CPU xxx-xxx」をダブルクリックします。

(9) MPI ポート設定のダイアログボックスが表示されます。[Properties] を開きます。

(10)「MPI(1)   187.5Kbps」が初期値として設定されていることを確認します。また、GP-Pro EX で設定

する相手先ノード番号 (PLC Address) となる [Address] も設定します ( 今回は初期値「2」のまま )。

「MPI(1)   187.5Kbps」を選択して [Properties] を開きます。

(11)[Network Settings] タブをクリックします。

(12)表示されたダイアログボックスで、通信速度 (Transmission rate) とノード番号の最大値 (Highest 

MPI address) を変更することができます ( 通信速度 [187.5Kbps] を選択します )。ノード番号の最大

値 (Highest MPI address) を変更 ( 今回は [31] に設定 ) する場合は、[Change] ボックスにチェックを

入れると、選択可能になります。設定完了後、 [OK] をクリックします。

(13)手順 12 で表示されたダイアログボックスで [OK] をクリックします。

(14)手順 19 で表示された MPI ポート設定のダイアログボックスで [OK] をクリックします。

(15)接続機器とラダーソフトの接続を確認します。メニューバーの [Options] → [Set PG/PC Interface] を

開きます。

(16)[Set PG/PC Interface] ダイアログボックスが表示されます。[Properites] をクリックします。

設定項目 設定内容

通信速度 187500 bps

相手先ノード番号 2

自局ノード番号
1( 任意：ノード番号最大値以下の値
を設定してください。)

ノード番号の最大値 31

使用可能 DB デバイス DB1

• S7-300 シリーズを使用する場合は、［2 SIMATIC 300 Station］を選択してください。
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(17)[Transmission] を [187.5Kbps]、[Highest Node Address] を [31] に設定し、[OK] をクリックします。

(18)次に [Diagnostics] をクリックします。

(19)[Test] と [Read] をクリックします。

(20)「OK」と表示され、[Bus Nodes] の [0-0] 以外にチェックが入っていれば接続機器との接続がされて

います。[OK] をクリックしてダイアログボックスを閉じます。

(21)プロジェクトの [CPU xxx-xxx] → [S7 Program(2)] の中の [Blocks] を開き、メニューバーより

[Insert] → [S7 Block] → [4 Data Block] をクリックします。

(22)[Properties - Data Black] ダイアログボックスが表示されます。そのまま [OK] をクリックします。

(23)[Block] 内に作成された [DB1] を開きます。[Type] の「INT」部分で右クリックし、[Complex 

Types] → [ARRAY] を選択します。

ARRAY の範囲は任意で設定します。ここでは、「0.3000」を入力します。

(24)[Type] が [ARRAY] に変更されると、その下に１行増えます。その部分で右クリックし、

[Elementary] → [WORD] を選択します。

(25)[Name] は任意で決めてください。そのままでも結構です。また、[Initial value]、]Comment] は空欄

でも問題ありません。保存してウィンドウを閉じます。

(26)「Configure Network」を開きます。「CPU 413-2 DP」を選択し、［Download］ボタンをクリックしま

す。

(27)「PLC Download Selected Stations」のダイアログボックスが表示されたら、「Yes」をクリックして

ダウンロードを進めます。

(28)ダウンロードが完了すると、ダイアログボックスが閉じます。

(29)[Configure Network] ウィンドウを閉じます。[Network Save and Compile] ダイアログボックスが表示

されたら [Yes] をクリックします。

(30)[Save and Compile] ダイアログボックスが表示されたら、[OK] をクリックします。

(31)[DB1] を接続機器にダウンロードします。[DB1] を選択し、[Download] ボタンをクリックします。

(32)[Download] ダイアログボックスが表示されたら、[Yes] をクリックしてダウンロードを進めます。

(33)ダウンロードが完了した場合、エラー表示などは表示されません。何も表示されていなければ、

接続機器の設定は完了です。

◆制限事項

■ドライバのバージョン V1.00.03 以下の制限事項

• S7-300/400 シリーズの TimeMaster 機能をサポートしていませんので、TimeMaster 機能を使用した

時刻合わせはできません。使用した場合、表示器の通信が数秒間途切れたり、通信エラーが表示

される場合があります。TimeMaster 機能を使用しないでください。

• 1 つの接続構成に S7-300/400 シリーズと S7-200 シリーズを混在させることはできません。

■ドライバのバージョン V1.00.04 以上の制限事項

• 通信速度は、最大 187500bps です。
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V1.00.03 以下で作成したプロジェクトで通信速度が 500kbps 以上に設定されていた場合、表示器

本体でエラー表示されます。

• 1 台の表示器で複数のドライバを使用する場合、Rockwell Automation, Inc の DH-485 ドライバと同

時に使用することはできません。

また、COM1 と COM2 の両方で SIMATIC S7 MPI 直結ドライバを使用することはできません。
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4 設定項目

表示器の通信設定は GP-Pro EX、または表示器のオフラインモードで設定します。

各項目の設定は接続機器の設定と一致させる必要があります。

「3 通信設定例」（6 ページ）

4.1 GP-Pro EX での設定項目

■ 通信設定

設定画面を表示するには、ワークスペースの [ システム設定ウィンドウ ] から [ 接続機器設定 ] を選択

します。

設定項目 設定内容

通信方式 接続機器と通信する通信方式を選択します。

通信速度

接続機器と表示器間の通信速度を選択します。

• 表示器の COM1 ポートに接続する場合は 19200 までサポートしています。
表示器の COM2 ポートに接続する場合は 187500 までサポートしています。

データ長 データ長を選択します。

パリティ パリティチェックの方法を選択します。

ストップビット ストップビット長を選択します。

フロー制御 送受信データのオーバーフローを防ぐために行う通信制御方式を選択します。
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■ 機器設定

設定画面を表示するには、[ 接続機器設定 ] の [ 機器別設定 ] から設定したい接続機器の （[ 設定 ]）

をクリックします。

[ 接続可能台数 ] が複数の場合は [ 接続機器設定 ] の [ 機器別設定 ] から をクリックすることで、設

定できる接続機器を増やすことができます。

タイムアウト 表示器が接続機器からの応答を待つ時間 (s) を「1 ～ 127」で入力します。

リトライ
接続機器からの応答がない場合に、表示器がコマンドを再送信する回数を「0 ～
255」で入力します。

送信ウェイト
表示器がパケットを受信してから、次のコマンドを送信するまでの待機時間
（ms）を「0 ～ 255」で入力します。

自局ノード番号 表示器の自局ノード番号を「0 ～ 126」で入力します。

ノード番号の最大値 ノード番号の最大値に [15]、[31]、[63]、[126] のいずれかを選択します。

スレーブとしてクロッ
ク同期する

チェックボックスにチェックを入れると Time Master の設定が有効となります。
Time Master の設定が有効になると、接続機器で設定した Time Interval の間隔で、
マスターの接続機器から表示器の時間データを書き換えます。マスターの接続機
器側の設定は、ラダーソフトで行います。設定は、「H/W Configuration」－＞
CPU の「Diagnostics Properties」－＞ Diagnostics/Clock のメニューで行います。詳
細は接続機器のマニュアルを参照してください。

設定項目 設定内容

PLC タイプ

通信する接続機器のタイプに［S7-300/400 シリーズ（英語表記）］、［S7-300/400
シリーズ（ドイツ語表記）］、［S7-200 シリーズ（英語表記）］、［S7-200 シリーズ
（ドイツ語表記）］のいずれかを選択します。
デバイス名を英語表記にするかドイツ語表記にするかによって（英語表記）、（ド
イツ語表記）を選択します。

相手先ノード番号
接続機器のノード番号を「0 ～ 126」で入力します。ただし、ノード番号は [ 通
信設定 ] の [ ノード番号の最大値 ] で設定した値を超えない範囲で設定してくだ
さい。

設定項目 設定内容
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4.2 オフラインモードでの設定項目

■ 通信設定

設定画面を表示するには、オフラインモードの [ 周辺機器設定 ] から [ 接続機器設定 ] をタッチしま

す。表示された一覧から設定したい接続機器をタッチします。

（1/2 ページ）

• オフラインモードへの入り方や操作方法は GP3000 シリーズユーザーズマニュアルを参

照してください。

参照：GP3000 シリーズユーザーズマニュアル　「4 章　設定」

設定項目 設定内容

通信方式 接続機器と通信する通信方式を選択します。

通信速度 接続機器と表示器間の通信速度を選択します。

データ長 データ長を選択します。

パリティ パリティチェックの方法を選択します。

ストップビット ストップビット長を選択します。

フロー制御 送受信データのオーバーフローを防ぐために行う通信制御方式を選択します。

タイムアウト 表示器が接続機器からの応答を待つ時間 (s) を「1 ～ 127」で入力します。

リトライ
接続機器からの応答がない場合に、表示器がコマンドを再送信する回数を「0 ～
255」で入力します。

送信ウェイト
表示器がパケットを受信してから、次のコマンドを送信するまでの待機時間
（ms）を「0 ～ 255」で入力します。
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（2/2 ページ）

設定項目 設定内容

自局ノード番号 表示器の自局ノード番号を「0 ～ 126」で入力します。

ノード番号の最大値 ノード番号の最大値に [15]、[31]、[63]、[126] のいずれかを選択します。

スレーブとしてクロッ
ク同期

チェックボックスにチェックを入れると Time Master の設定が有効となります。
Time Master の設定が有効になると、接続機器で設定した Time Interval の間隔で、
マスターの接続機器から表示器の時間データを書き換えます。マスターの接続機
器側の設定は、ラダーソフトで行います。設定は、「H/W Configuration」－＞
CPU の「Diagnostics Properties」－＞ Diagnostics/Clock のメニューで行います。詳
細は接続機器のマニュアルを参照してください。
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■ 機器設定

設定画面を表示するには、[ 周辺機器設定 ] から [ 接続機器設定 ] をタッチします。表示された一覧か

ら設定したい接続機器をタッチし、[ 機器設定 ] をタッチします。

設定項目 設定内容

接続機器名
機器設定を行う接続機器名を表示します。接続機器名は GP-Pro EX で設定する接
続機器の名称です。（初期値 [PLC1]）

シリーズ

GP-Pro EX の [ 機器設定 ] で選択した PLC タイプが表示されます。
オフラインモードの [ 機器設定 ] では PLC タイプを変更できません。

「4.1 GP-Pro EX での設定項目 ■機器設定」（1-14 ページ）

相手先ノード番号
接続機器のノード番号を「0 ～ 126」で入力します。ただし、ノード番号は [ 通
信設定 ] の [ ノード番号の最大値 ] で設定した値を超えない範囲で設定してくだ
さい。
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5 結線図

以下に示す結線図と Siemens AG の推奨する結線図の異なる場合がありますが、本書に示す結線図で

も動作上問題ありません。

• 接続機器本体の FG 端子は D 種接地を行ってください。詳細は接続機器のマニュアルを参照して

ください。

• 表示器内部で SG と FG は接続されています。接続機器と SG を接続する場合は短絡ループが形成

されないようにシステムを設計してください。

結線図 1

表示器

（接続ポート）
ケーブル 備考

GP※ 1（COM1）※ 2

AGP-3302（COM2）

※ 1 AGP-3302 を除く全 GP 機種

※ 2 S7-200 シリーズを接続する場合のみ COM1 ポートを使用できます。

A 自作ケーブル

ケーブル長は 1 つの
セグメントで 50m
以内にしてくださ
い。

B

（株）デジタル製 COM ポート変換アダプタ (COM1 用 )
CA3-ADPCOM-01

＋
（株）デジタル製 コネクタ端子台変換アダプタ

CA3-ADPTRM-01
＋

自作ケーブル

GP ※ 1（COM2）

C

（株）デジタル製 オンラインアダプタ
CA4-ADPONL-01

＋
自作ケーブル

D

（株）デジタル製 オンラインアダプタ
CA4-ADPONL-01

＋
（株）デジタル製 コネクタ端子台変換アダプタ

CA3-ADPTRM-01
＋

自作ケーブル
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A) 自作ケーブルを使用する場合

• 1:1 接続の場合

• 1:n 接続の場合
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• n:1 接続の場合
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B)（株）デジタル製 COM ポート変換アダプタ（COM1 用）（CA3-ADPCOM-01）、（株）デジタル製 コ

ネクタ端子台変換アダプタ（CA3-ADPTRM-01）、および自作ケーブルを使用する場合

• 1:1 接続の場合

• 1:n 接続の場合

• n:1 接続の場合
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C)（株）デジタル製 オンラインアダプタ（CA4-ADPONL-01）および自作ケーブルを使用する場合

• 1:1 接続の場合

• 1:n 接続の場合

• n:1 接続の場合

• 表示器側と接続機器側を逆に接続した場合、CPU ユニットの破壊、故障の原因となりま
す。
ケーブルの表示器側・接続機器側を確認し、正しく接続してください。

• 表示器を複数台接続する場合、オンラインアダプタは 1 台の表示器にのみ使用してくだ
さい。
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D)（株）デジタル製 オンラインアダプタ（CA4-ADPONL-01）、（株）デジタル製 コネクタ端子台変換

アダプタ（CA3-ADPTRM-01）、および自作ケーブルを使用する場合

• 1:1 接続の場合

• 1:n 接続の場合

• n:1 接続の場合

• 表示器側と接続機器側を逆に接続した場合、CPU ユニットの破壊、故障の原因となりま
す。
ケーブルの表示器側・接続機器側を確認し、正しく接続してください。

• 表示器を複数台接続する場合、オンラインアダプタは 1 台の表示器にのみ使用してくだ
さい。
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結線図 2

この結線図は以下に示す MPI と PROFIBUS が同じポートの機種専用です。

SIMATIC S7-300 シリーズ 318-2(6ES7 318 2AJ00)

SIMATIC S7-400 シリーズ

412-1 (6ES7 412 1XF03)、412-2DP (6ES7 412 2XG00)、
414-2DP (6ES7 414 2XG03)、414-3DP (6ES7 414-3XJ00)、
416-2DP (6ES7 416 2XK02)、416-3DP (6ES7 416-3XL00)、
417-4 (6ES7 417-4XL00)

表示器

（接続ポート）
ケーブル 備考

AGP-3302（COM2）

A 自作ケーブル

ケーブル長は 1 つの
セグメントで 50m
以内にしてくださ
い。

B

（株）デジタル製 COM ポート変換アダプタ（COM1 用）
CA3-ADPCOM-01

＋
（株）デジタル製 コネクタ端子台変換アダプタ

CA3-ADPTRM-01
＋

自作ケーブル

C

( 株 ) デジタル製 COM ポート変換アダプタ（COM1 用）
CA3-ADPCOM-01

＋
( 株 ) デジタル製 シーメンス COM ポート変換アダプタ

CA3-ADPSEI-01
＋

自作ケーブル
(Siemens 製 PROFIBUS コネクタ※ 1 ※ 2 使用 )

※ 1 GP-3300 シリーズを除く GP の場合、PROFIBUS コネクタは形状が 180°Cable outlet のものを使用し
てください。

※ 2 PROFIBUS コネクタには通信速度に制限があるものがありますので注意してください。

GP※ 3（COM2）

※ 3 AGP-3302 を除く全 GP 機種

D

（株）デジタル製 オンラインアダプタ
CA4-ADPONL-01

＋
自作ケーブル

E

（株）デジタル製 オンラインアダプタ
CA4-ADPONL-01

＋
（株）デジタル製 コネクタ端子台変換アダプタ

CA3-ADPTRM-01
＋

自作ケーブル

F

（株）デジタル製 シーメンス COM ポート変換アダプタ
CA3-ADPSEI-01

＋
自作ケーブル

(Siemens 製 PROFIBUS コネクタ※ 1 ※ 2 使用 )
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A) 自作ケーブルを使用する場合

• 1:1 接続の場合

• 1:n 接続の場合

• n:1 接続の場合

Dsub 9 ( )

Dsub 9 ( )
220Ω

220Ω

SDA

RDA

RDB

SDB

3

7

1

2

9

8

4

SG

ERB

CSA

CSB

ERA

FG

5

6

SHIELD

A

B3

8

Dsub 9 ( )

Dsub 9 ( )
220Ω

SDA

RDA

RDB

SDB

3

7

1

2

9

8

4

SG

ERB

CSA

CSB

ERA

FG

5

6

SHIELD

A

B3

8

220Ω

Dsub 9 ( )

SHIELD

A

B3

8

Dsub 9 ( )

220Ω

220Ω

SDA

RDA

RDB

SDB

3

7

1

2

9

8

4

SG

ERB

CSA

CSB

ERA

FG

5

6

Dsub 9 ( )

SDA

RDA

RDB

SDB

3

7

1

2

Dsub 9 ( )

9

8

4

SG

ERB

CSA

CSB

ERA

FG

5

6

SHIELD

A

B3

8



SIMATIC S7 MPI 直結 ドライバ

GP-Pro EX 機器接続マニュアル 26

B)（株）デジタル製 COM ポート変換アダプタ（COM1 用）（CA3-ADPCOM-01）、（株）デジタル製 コ

ネクタ端子台変換アダプタ（CA3-ADPTRM-01）、および自作ケーブルを使用する場合

• 1:1 接続の場合

• 1:n 接続の場合

• n:1 接続の場合
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C)（株）デジタル製 COM ポート変換アダプタ（COM1 用）（CA3-ADPCOM-01）、（株）デジタル製

シーメンス COM ポート変換アダプタ（CA3-ADPSEI-01）、および自作ケーブル (Siemens 製

PROFIBUS コネクタ使用 ) を使用する場合

• 1:1 接続の場合

• 1:n 接続の場合

• n:1 接続の場合
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D)（株）デジタル製 オンラインアダプタ（CA4-ADPONL-01）、および自作ケーブルを使用する場合

• 1:1 接続の場合

• 1:n 接続の場合

• n:1 接続の場合

• 表示器側と接続機器側を逆に接続した場合、CPU ユニットの破壊、故障の原因となりま
す。
ケーブルの表示器側・接続機器側を確認し、正しく接続してください。

• 表示器を複数台接続する場合、オンラインアダプタは 1 台の表示器にのみ使用してくだ
さい。
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E)（株）デジタル製 オンラインアダプタ（CA4-ADPONL-01）、（株）デジタル製 コネクタ端子台変換

アダプタ（CA3-ADPTRM-01）、および自作ケーブルを使用する場合

• 1:1 接続の場合

• 1:n 接続の場合

• n:1 接続の場合

• 表示器側と接続機器側を逆に接続した場合、CPU ユニットの破壊、故障の原因となりま
す。
ケーブルの表示器側・接続機器側を確認し、正しく接続してください。

• 表示器を複数台接続する場合、オンラインアダプタは 1 台の表示器にのみ使用してくだ
さい。
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F)（株）デジタル製 シーメンス COM ポート変換アダプタ（CA3-ADPSEI-01）および自作ケーブル

(Siemens 製 PROFIBUS コネクタ使用 ) を使用する場合

• 1:1 接続の場合

• 1:n 接続の場合

• n:1 接続の場合

• 表示器側と接続機器側を逆に接続した場合、CPU ユニットの破壊、故障の原因となりま
す。
ケーブルの表示器側・接続機器側を確認し、正しく接続してください。

• 表示器を複数台接続する場合、オンラインアダプタは 1 台の表示器にのみ使用してくだ
さい。
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6 使用可能デバイス

使用可能なデバイスアドレスの範囲を下表に示します。ただし、実際にサポートされるデバイスの範

囲は接続機器によって異なりますので、ご使用の接続機器のマニュアルで確認してください。

6.1 S7-200 シリーズ

はシステムデータエリアに指定できます。

デバイス
ビットアドレス ワードアドレス 32

bits 備考
英語 ドイツ語 英語 ドイツ語

変数 － VW00000 - VW05118

入力
I00000.0 - 
I00015.7

E00000.0 -  
E00015.7

IW00000 - 
IW00014

EW00000 - 
EW00014  ※ 1

※ 1 CPU の種類によっては IW0 ～ IW2 への書き込みはできません。これらのアドレスはオンボード I/O
のために予約されています。ご使用の接続機器のマニュアルで確認してください。

出力
Q00000.0 - 
Q00015.7

A00000.0 - 
A00015.7

QW00000 - 
QW00014

AW00000 - 
AW00014  ※ 2

※ 2 接続機器が RUN 中のみ QW および Q デバイスへの書き込みが可能です。接続機器が STOP モード
に移行すると出力はリセットされます。

内部マーカー M00000.0 - M00031.7 MW00000 - MW00030

タイマ － T00000 - T00255 ※ 3

※ 3 書き込み不可。

カウンタ －
C00000 - 
C00255

Z00000 - 
Z00255

※ 3

• システムデータエリアについては GP-Pro EX リファレンスマニュアルを参照してくださ

い。

参照：GP-Pro EX リファレンスマニュアル「付録 1.4 LS エリア（ダイレクトアクセス方

式専用）」

• 表中のアイコンについてはマニュアル表記上の注意を参照してください。

「表記のルール」
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6.2 S7-300/400 シリーズ

はシステムデータエリアに指定できます。

デバイス
ビットアドレス ワードアドレス 32

bits 備考
英語 ドイツ語 英語 ドイツ語

データブロック
DB00001.DBX00000.0 - 
DB65535.DBX65533.7

DB00001.DBW00000 - 
DB65535.DBW65532

※ 1

※ 1 ビット書き込みを行うと、表示器はいったん接続機器の該当するワードアドレスを読み込みます。
読み込んだワードデータのうち対象とするビットのみを変更し、そのワードデータを接続機器に書
き込みます。
表示器が接続機器のデータを読み込んで接続機器へ書き込むまでの間に、そのワードアドレスの値
をラダープログラムで変更すると、正しいデータが書き込まれない場合があるので注意してくださ
い。

入力
I00000.0 - 
I00127.7

E000000.0 - 
E00127.7

IW00000 - 
IW00126

EW00000 - 
EW00126

出力
Q00000.0 - 
Q00127.7

A00000.0 -  
A00127.7

QW00000 - 
QW00126

AW00000-
AW00126

内部マーカー M00000.0 - M00511.7 MW00000 - MW00510

タイマ － T00000 - T00255 ※ 2

※ 2 書き込み不可。

カウンタ －
C00000 - 
C00255

Z00000 - 
Z00255

※ 2

• システムデータエリアについては GP-Pro EX リファレンスマニュアルを参照してくださ

い。

参照：GP-Pro EX リファレンスマニュアル「付録 1.4 LS エリア（ダイレクトアクセス方

式専用）」

• 表中のアイコンについてはマニュアル表記上の注意を参照してください。

「表記のルール」
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7 デバイスコードとアドレスコード

デバイスコードとアドレスコードはデータ表示器などのアドレスタイプで「デバイスタイプ＆アドレ

ス」を設定している場合に使用します。

7.1 S7-200 シリーズ

7.2 S7-300/400 シリーズ

デバイス
デバイス名 デバイスコード

（HEX）
アドレスコード

英語 ドイツ語

変数 V V 0001 ワードアドレス÷ 2 の値

入力 I E 0080 ワードアドレス÷ 2 の値

出力 Q A 0081 ワードアドレス÷ 2 の値

内部マーカー M M 0082 ワードアドレス÷ 2 の値

タイマ T T 0060 ワードアドレス

カウンタ C Z 0061 ワードアドレス

デバイス
デバイス名 デバイスコード

（HEX）
アドレスコード

英語 ドイツ語

データブロック DB DB 0000 （データブロック番号× 0x10000）
+（ワードアドレス÷ 2）の値

入力 I E 0080 ワードアドレス÷ 2 の値

出力 Q A 0081 ワードアドレス÷ 2 の値

内部マーカー M M 0082 ワードアドレス÷ 2 の値

タイマ T T 0060 ワードアドレス

カウンタ C Z 0061 ワードアドレス
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8 エラーメッセージ

エラーメッセージは表示器の画面上に「番号：機器名：エラーメッセージ（エラー発生箇所）」のよ

うに表示されます。それぞれの内容は以下のとおりです。

エラーメッセージの表示例

「RHAA035:PLC1: 書込み要求でエラー応答を受信しました（受信エラーコード：2[02H]）」

項目 内容

番号 エラー番号

機器名
エラーが発生した接続機器の名称。接続機器名は GP-Pro EX で設定する接続機器
の名称です。（初期値 [PLC1]）

エラーメッセージ 発生したエラーに関するメッセージを表示します。

エラー発生箇所

エラーが発生した接続機器の IP アドレスやデバイスアドレス、接続機器から受
信したエラーコードを表示します。

• 受信したエラーコードは「10 進数 [16 進数 ]」のように表示されます。
• IP アドレスは「IP アドレス (10 進数 )：MAC アドレス (16 進数 )」のように表
示されます。

• 受信したエラーコードの詳細は、接続機器のマニュアルを参照してください。
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